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Lesson 1-1: Google Sites Overview 

 

With Google Sites, you can easily create and update your own department, school or 
teacher web site. Google Sites allows you to display a variety of information in one 
place—including videos, photo slideshows, images, calendars, presentations, 
attachments, and text—and share it for viewing or editing with a small group, an 
entire organization, or the world. You always control who has access to your site. 

Here's what you can do with Google Sites:  

 Customize your site.  

 Create subpages to keep your content organized.  

 Choose page types: webpage, announcements, file cabinet or list page. 

 Have a central location for your web content and offline files. 

 Keep your site as private or public as you would like. 

 Search across your Google Sites content with Google search technology.  

  

 

Figure 1-1 

Jeffco Schools Site 
Template 
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Lesson 1-2: Web Page Layout 

 

A web page is the simplest kind of page. You can: 

 write content 

 embed gadgets 

 arrange it however you like using predesigned layouts 

 apply standard formatting controls like bold, italic, and underline, bullets, 
and more 

 attach or link to documents  

Google Sites saves versions of your page as you make edits, so it’s easy to go back to 
earlier versions of the page to make comparisons or undo changes. 

Please see Chapter Two: Getting Started with Google Sites for complete details on 
how to add this type of page to your website, how to configure the page settings, 
page layout and so much more. 

Figure 1-2 

Web Page Layout 
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Lesson 1-3: Announcements Page Layout 

 

Figure 1-3 

Much like a blog, announcement pages display posts you make to the page in 
chronological order, starting with the most recent post. You can do everything you 
can do in a web page on an announcement page. The primary difference is the 
announcement page will list each post and is more dynamic. The announcement 
page can also be inserted as a gadget (think of it as a page summary) on any other 
page type. 

Please see Chapter Two: Getting Started with Google Sites for complete details on 
how to add this type of page to your website, how to configure the page settings, 
page layout and so much more. 

Figure 1-3 

Announcements Page 
Style 
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Lesson 1-4: File Cabinet Page Layout 

Figure 1-4 

 

The file cabinet page is where you can upload, store and organize files and links from 
your computer’s hard drive, network drive, or from the cloud making it an easy way 
to share files with other users of your site. You can even organize your files under 
folders. Anyone subscribed to the page will be notified when files are added, 
changed, or removed. The file cabinet page can also be inserted as a gadget (think of 
it as a page summary) on any other page type. 

 

Figure 1-4 

File Cabinet Page 
Layout 
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Lesson 1-5: List Page Layout 

Figure 1-5 

List pages let you design and organize lists of information. Items on the list are easy 
to add, edit, and remove, and viewers of the list can sort it by any column. Like the 
file cabinet page, subscribers are notified when items are added, changed, or 
removed. The list page can also be inserted as a gadget (think of it as a page 
summary) on any other page type. 

Figure 1-5 

List Page Layout 

 



 

 

 

Chapter Two: Getting 
Started with Google Sites 

Chapter Objectives: 

 How to access and login to Google Sites 

 How to create a Site 

 How to add pages to a Site 

 How to set Page Settings 

 How to select a Page Layout 

 How to edit your Web Page 

 How to insert images on a Page 

 How to link to files or other web pages 

 How to manage attachments on a page 

 How to replace attachments and not break the link 

 How to delete a page from your site 
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Lesson 2-1: Starting Google Sites 

       

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2-1 

 
Figure 2-2 

Figure 2-1 

Jeffco Google Apps 
Resources page 

Figure 2-2 

Google Apps Login 
Page 
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All Jeffco employees and students have a Jeffco Google Account.  You may login to 
your Google account from the Jeffco Google Apps website.  

Employees must enter their Google Gmail address (this is not the same as their 
Microsoft Exchange (Outlook or OWA) email address) in the email field provided. 
Employee Google passwords are the same as their Active Directory (AD) Password.  

The following Google Gmail and Password are provided as an example only: 

Email: jsmith@jeffcoschools.us 

Password: jsmith123 

NOTE: if you are unable to login using these instructions, please try resetting your 
password using the Password Reset Tool. We have found that this often times fixes 
any “invalid Password” errors. You may access the Password Reset Tool by following 
these instructions: 

1. From the Employee Connections homepage, select Technology on the left 
navigation and then from the main window click on Password Reset – For 
Employees. 

2.  Follow the steps for How to Register for the Password Reset Tool. 

Only if that does not work, please contact the Service Desk by: 

 submitting a self-service ticket using Access Jeffco 
or 

 emailing service_desk@jeffco.k12.co.us 

 or 

 calling 303-982-2200 

mailto:service_desk@jeffco.k12.co.us
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Lesson 2-2: Creating a Site 

Figure 2-3 

Figure 2-4 

Once you've signed in to your Google Account, you can start creating your site. 
Here's how: 

1. Click the  button as illustrated in Figure 2-3. 

2. Enter a name for your site in the Name your site field as illustrated in Figure 
2-4.  

3. To select a template for your website: 

Click the Browse the gallery for more link to search for jeffcoschools.us 
templates. This is where you would search for one of the Jeffco School templates 
(there are 3 different styles), the Jeffco Department template, or teacher 
templates created by your school. If you select a template from this gallery, you 

Figure 2-3 

Google Sites start 
page 

Figure 2-4 

Create a Site page 
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will start your website using a collection of webpages that can then be 
customized. 

4. Click on the   button. 

Now that you've created your site, you can customize the site by adding new 
pages and adding content to pages. 
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Lesson 2-3: Adding New Pages to your 
Site 

       
Figure 2-5                                                                    Figure 2-6 

When you create a new page for your Google Site, you can choose from the 
following page types: 

Web Page (please see Lesson 1-2: Web Page Layout for an illustration of this page 
type). 

Announcements (please see Lesson 1-3: Announcements Page Layout for an 
illustration of this page type). 

File Cabinet (please see Lesson 1-4: File Cabinet Page Layout for an illustration of 
this page type). 

List (please see Lesson 1-5: List Page Layout for an illustration of this page type). 

Follow these steps to create new pages within your site: 

1. From your home page, click the New page icon.  

2. Enter a name for your page in the Name your page text box as illustrated in 
Figure 2-5. This will be the name that appears on the navigation bar as well as 
at the top of your web page depending on how you set your preferences in 
Page settings. 

Figure 2-5 

New page dialog box 

Figure 2-6 

Web Page drop-down 
menu 
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3. Google Sites will generate a URL (web address) based on the name you choose, 
but you can alter it by clicking change URL.  

4. Select a template to use from the page template drop-down list as illustrated 
in Figure 2-6.   

5. Click on the Create button. 

6. Click on the Save button.  

You can create as many pages as you need within a web site. 

How to edit your page title: 

1. From your homepage, click the Edit page icon.  

2. Your page title will be in the top text box in your page's main content area. 
Change this to be whatever you want your page to be named. NOTE: this does 
not change the URL for the page. To change the page url, go to the Open More 
actions menu and select Page settings. 

3. Edit your web page content. 

4. Click the Save button. 

How to hide your page title: 

If you do not want your page name to appear at the top of the page, you can turn 
your page name off:  

1. Navigate to the page whose page title you want to turn off.  

2. From the Open More actions menu, select Page settings.  

3. Uncheck the checkbox next to Show page title. 

4. Click the Save button. 

Please note that hiding your page title will not 
prevent your page title from displaying on your 
navigation bar when using automatic navigation. 
To do this, you will need to disable automatic navigation. Please see:   

Lesson 4-4: How to Manually Organize Sidebar Navigation. 
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Lesson 2-4: Page Settings 

 
Figure 2-7 

Page settings may be set independently for each page type: 

Show page title: by default page titles will display at the top of your web page. If you 
do not want the page title to display, uncheck this box.  

Page titles are assigned when a new page is added (please see Lesson 2-2: Creating a 
Site). Page titles may be changed by editing the title on the page. This will also 
change the page name on the navigation bar. 

Show links to subpages: by default links to subpages will display at the bottom of 
the top-level web page. If you do not want them to display, uncheck this box. 
Subpages may be structured under top-level web pages when a new page is 
added or by editing the navigation. 

Allow attachments: by default pages provide an Allow attachments section at the 
bottom of the web page. To turn this feature off, uncheck this box. 

Allow comments: by default pages provide an Allow comments section at the 
bottom of the web page. To turn this feature off, uncheck this box. 

Figure 2-7 

Page Settings 
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Page description: you may optionally enter a page description. It does not display 
anywhere on the page; the page description only appears here. 

Page URL: the page URL is assigned at the time you add a new page. You may edit 
the Page URL in the field provided. NOTE: you may effectively have a different page 
title than your page url. 

Currently using page template <page style> (Change): the template being used for 
the page you are on will display here. To change this template, click on the Change 
link. CAUTION: if you change from one template to another, you may need to 
rearrange the information.  
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Lesson 2-5: Assigning a Page Layout 

 Figure 2-8 

Each page may have its own page layout applied as illustrated in Figure 2-8. To apply 
a page layout to a page: 

1. Go to the page you want to apply a page layout.  

2. Click on the Edit page icon.  

3. Click on the Layout tab.  

By default pages are assigned a one column (simple) page layout. Select any of 
the layouts illustrated in Figure 2-8 for your page. Only one layout style may be 
selected for a page at any given time. You may change the layout style at any 
time, but be aware that the contents of the containers may not display nicely 
with the new layout and you will most likely need to rearrange the information.  

NOTE: layout containers are a fixed size horizontally across the page; however, they 
can become larger vertically as you add more and more content. 
  

Figure 2-8 

Layout tab  

 



 Getting Started with Google Sites 21 

 

Jeffco Schools 

 



22 Google Sites 

IT Training Center, 6.30.15 

Lesson 2-6: Edit your Web Page 

 
Figure 2-9 

 

 
Figure 2-10 

To edit your site, click the Edit page button in the upper right of the screen. 

The edit toolbar will provide you with the tools necessary to edit your site. 

Here's what each option does: 

Undo and redo changes 

 

You can undo and redo changes by clicking the arrow 
buttons in the toolbar. You can also use these keyboard 
shortcuts: 

Undo (Ctrl-z) 

Redo (Ctrl-y or Shift-Ctrl-z) 

Change the font type 
and size 

 

 

You can select the font type and size using the two drop-
down menus. 

 

Edit text 

 

Add boldface type and italics, underline text, and change 
the color of your text or text background:  

B adds boldface type  

I allows you to italicize 

U underlines text 

A changes text color 

Figure 2-9 

Edit Toolbar 

Figure 2-10 

Edit Toolbar 
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 changes the text background color 

 

Create a link 

 

 

Highlight the text that you want to turn into a link, and 
click the Link icon. For detailed instructions on creating 
links, please see Lesson 2-8: Linking to files or pages. 

 

Create a list  

 

 

Click the Numbered list icon or the Bulleted list icon, 
depending on the type of list you need to add to the site. 
Then type the first item, and press Enter. The next 
number or bullet point appears. 

The Tab key can help you indent your bullet points, while 
the Enter key will move back your indentation.  

 

Indent or move your list 

 

Click the two buttons next to the bulleted list to indent or 
move back the starting point when adding a bulleted or 
numbered list or regular text. Click twice to move each 
item two spaces, and so forth. 

 

Align your text 

 

 

Use these buttons for your page alignment. You have the 
option to align the text on your page left, center, or right. 

 

Remove formatting and 
edit HTML source 

 

 

You can remove the formatting from any part of your page 
by highlighting the relevant text and clicking the Remove 
formatting icon. 

Click the HTML icon to edit the HTML on your site. Please 
keep in mind that only a limited amount of editing can be 
done. Some advanced coding may not work. 
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Lesson 2-7: Insert Images to your Page 

Figure 2-11 

Figure 2-12 

 
Figure 2-13 

It's easy to enhance your site by adding images from your computer or online 
images: 

1. Navigate to the page where you would like to place your image and click on 

the  Edit page icon. 

2. From the Insert menu, select  as illustrated in Figure 2-11. 

Figure 2-11 

Insert tab 

Figure 2-12 

Add an Image dialog 
box 

Figure 2-13 

Image Editing toolbar 
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3. If you have your image on your computer, click on the Upload Images button 
as illustrated in Figure 2-12 and browse to select the image. If you want to use 
an image you found online, click on the option button next to Web address 
(URL) and then enter the URL of the image in the box next to Image URL. 
NOTE: if you want to insert an image from your Picasa account, you should 
select Insert>Google+>Photo. 

4. Click the OK button.  

5. Once the image is placed on the page, use the Image Editing toolbar as 
illustrated in Figure 2-13 to do the following: 

6. To align the position of the image in the page’s text box, click on the 
appropriate image align icon (left, center or right). 

7. To change the size of the image, select S for small, M for medium, L for large, 
or Original for the full size of the uploaded image. 

8. If you want to have text wrap around the image, click on the Wrap on icon. 

9. When you have finished making edits to the page, click the Save button to 
preserve all changes to the current page.  

Any new image you add is either automatically linked to itself or to an external 
website. If a visitor clicks on it, it will click through to a full version of the image in its 
own window, or to an external website - unless you remove the link.  

Google Sites doesn't currently support uploading animated GIFs (this is generally a 
bad web design idea anyway). You may upload most other types of image files, but if 
they are not JPG or PNG format, they will be converted to either JPG or PNG. 
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Lesson 2-8: Linking to files or pages 

 
Figure 2-14 

 
Figure 2-15 

Adding links is an easy way to help visitors better navigate your site, and provide 
further information: 

1. Navigate to the page where you would like to add links and click on the  
Edit page icon.  

2. Highlight the text you would like to turn into a link and click on the Link icon 
on the toolbar (or select the Insert tab and click on Link).  

The Create Link dialog box will display as illustrated in Figure 2-14. You can 
choose from the following when creating links: 

Sites page: if you would like to link to an existing page on your site, select the 
Sites page item. You can then find the page you want by searching for its name, 
looking through your Site map, or if you have edited it recently, finding it in your 
list of My Recent Changes.   
 
If you would like to link to a new page on your site, select the Sites page item 
and click the Create new page button. You will be prompted to give the page a 

Figure 2-14 

Create Link to Sites 
page 

Figure 2-15 

Create Link to Web 
address 
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title, choose a page type and choose where to place the page. Finally, click on 
the Create page button.  

Web address: if you want to link to a page on another website, select the Web 
address item and enter the URL of the page you want to link to in the box below 
Link to this URL as illustrated in Figure 2-15. 

Regardless of what type of link you choose, if you would like the linked page to 
open in a new browser window or tab when a visitor clicks on it, check the box 
next to Open this link in a new window.  

3. Click the OK button. 

4. Continue editing your page or click on the Save button to preserve all changes 
to the current page. 

Linking to files on your site 

1. Navigate to the page containing the file. This may be a file attachment on a 
page, a file on one of your File Cabinet pages, or a file in Google Drive. 

2. Using Google Chrome as your browser, mouse over the file’s Download link 
and right-click to select Copy Link. (If getting a link for a Google Doc, get the 
Share link. Also, make sure the Google Doc is shared properly.) 

3. Navigate to the page where you want to link to the file and click the  Edit 
page icon.  

4. Highlight the text to be linked and click on the Link icon on the toolbar.  

5. Select the Web address item and enter the copied link address in the box 
below Link to this URL.  

6. Click on the OK button.  

7. Continue editing your page or click on the Save button to preserve your 
changes.  
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Lesson 2-9: Inserting Tables to a Page 

 Figure 2-16 

Using tables will seem like a great idea if you are a fan of using tables. However, 
please know that at the time of this writing, tables in Google Sites are limited in 
their features and functionality. If you know HTML, you may be successful in 
controlling the appearance of your table. 

How to insert a table 

1. Go to the page you want to insert a table and click on the Edit page icon. 

2. Click into the area of the page you want to insert the table, click on the Table 
tab on the menu bar and mouse over Insert table.  Drag your mouse across 
and down the number of columns and rows for which you want your table size 
and click in the last cell of the row. Using this tool, you can create up to a 20 x 
20 table. 

3. The table will be placed, left aligned, on your page. The cells of the table will 
automatically expand as you type into them.  Unfortunately, there is very little 
else you can do with this table without editing the HTML. Please reference the 
Table tab illustrated in Figure 2-16 for inserting and deleting rows and 
columns. 

4. Finish editing your page and click on the Save button to preserve your changes. 

 

 

Figure 2-16 

Table tab 
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Adjusting tables 

You may adjust the row and column size by:  

1. Click inside a cell of the table. 

2. Resizing handles will appear. Drag the resizing handles to make the column 
width and row height larger or smaller.   
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Lesson 2-10: Managing Attachments on a 
Page 

Figure 2-17 

 
Figure 2-18 

Site owners can enable a setting that lets editors of their site to upload attachments 
on a site page. Anyone viewing the site can download and view attachments. If the 
owner does not want to allow attachments on the page, they may disable the 
feature from the Page Settings dialog box. Please see Lesson 2-4: Page Settings for 
details. 

Uploading attachments 

1. Navigate to the page that you'd like to upload an attachment.  

2. Click the Add files link at the bottom of the page as similarly illustrated in 
Figure 2-17.  

3. Browse for the file you would like to upload and click on the Open button.  

4. NOTE: Attachments are limited to 20 MB or smaller. 

Sharing attachments from your site 

If you would like to share attachments from your site, you must have the person you 
are sharing the attachment with visit the page that the attachment is on, then click 
to download the attachment. That means that the person you are sharing the 
attachment with must have access to your site.  

In order to keep your site secure, you cannot just provide a link directly to the 
attachment.  

Figure 2-17 

Attachments 

Figure 2-18 

Manage 
Site/Attachments 
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Deleting attachments 

Only the creator of the attachment or an owner of the site may remove 
attachments.  

To delete an attachment, users can navigate to the page where the attachment is 
located, and then click the delete  icon located on the right of the attachment.  

Viewing attachments on your site 

You can manage your site attachments from the attachment management section of 
Sites:  

1. Select Manage site from the Open More actions menu.  

2. Select the Attachments tab from the left navigation menu.  

You'll be taken to a list of all of your attachments for the site. Here, you can 
rename, move, delete or replace your attachments using the toolbar as similarly 
illustrated in Figure 2-18 . 
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Lesson 2-11: How to Delete a Page from 
your Site 

 
Figure 2-19 

NOTE: you may not delete your Home (Landing) Page. The Delete page feature will 
be disabled. To delete a page designated as your Home Page, you must make 
another page the Home Page first. This can be done under the Manage site>General 
page by clicking the Change link under the Landing page section. 

To delete a page: 

1. Go to the page you want to delete. 

2. Click the  button. 

3. Select . 

4. Confirm you want to delete the page by clicking the  button. 

If you delete a page, its subpages and attachments will be removed. If you 
accidentally delete a page, you have 30 days to recover the deleted page. You 
will also be given the option to restore its subpages and attachments. 

To recover a deleted page: 

If you accidentally delete a page, you have 30 days to recover the deleted page and 
restore its subpages and attachments. To recover a deleted page: 

1. Select Manage site from the   button. 

Figure 2-19 

Delete page 
confirmation 
message 
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2. Select the Deleted items tab. 

3. Click the box next to the page you would like to recover. 

4. Click the  button. 

On the Deleted items tab, you can also see how long each page has left before it 
will be deleted permanently by looking under the Delete permanently column. 
If you want to delete a page permanently right away, you can click the box next 

to the page and click the button. Be careful, though – you 
cannot undo this action. 





 

 

 

Chapter Three: 
Inserting/Embedding 
Other Google Apps into 
your Site 

Chapter Objectives: 

 Inserting Gadgets 

 Adding Objects and Apps 

 Embedding Photos from Google+ Photos 

 Inserting Videos 

 Inserting Google Calendars 

 Inserting Google Forms 
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Lesson 3-1: Introduction to Gadgets 

Figure 3-1 

To summarize an announcement, file cabinet or list page, select one of these gadget 
types from the Insert menu. The following lessons will provide details on how to 
select gadget preferences. 
  

Figure 3-1 

Insert tab 
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Lesson 3-2: How to insert a Recent Posts 
Gadget 

 
Figure 3-2 

The Announcement, List, and File Cabinet page types allow you to summarize them 
on a web page (or any other page type) through the use of a gadget. First, you must 
create one of these page types before it can be summarized using a gadget. 

 To use the Announcements gadget, add it to your page by selecting Insert >> Recent 
Posts while in edit mode of any page in your site.   

Once added, you can configure the gadget based on the following options as 
illustrated in Figure 3-2: 

 Show posts from: this option provides a drop-down list of all 
Announcements pages on your site.  Select the one that is most appropriate 
for your needs. 

 Post length: the post length section allows you to select how much to 
display for each post. 

Figure 3-2 

Insert tab>Recent 
posts 
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 Short snippet: will display approximately 2 lines of the post. 

 Medium snippet: will display approximately 6 lines of the post. 

 Full post: will display the full announcement. 

 Include thumbnail of first image in post: check the box to include the first 
image in a post, if one exists. 

 Number of posts to display: you may limit the number of posts to display 
before displaying a View more>> link.  Clicking on the View more>> link will 
take you to the Announcement page containing the posts. 

 Add an intro post to your announcements: this option enables you to add 
an introduction to the top of the Recent Posts gadget.  Any content added 
here will appear below the gadget title, and above the first post. Click on the 
+ icon to open the text editor. 

Display:  

 Include border around recent announcements: places a border around the 
gadget, if selected. 

 Include title: adds a title to the top of the gadget, if selected. 

Click on the Save button to save your changes and close the dialog box.  

Click on the Save button for the page to save your changes and exit edit mode. 
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Lesson 3-3: How to insert a Recently 
Updated Files Gadget 

 
Figure 3-3 

The Announcement, List, and File Cabinet page types allow you to summarize them 
on a Web Page (or any other page type) through the use of a gadget. First, you must 
create one of these page types before it can be summarized using a gadget. 

To use the File Cabinet gadget, add it to your page by selecting Insert >> Recently 
updated files while in edit mode of any page in your site.   

Once added, you can configure the gadget based on the following options as 
illustrated in Figure 3-3: 
Show files from: this option provides a drop-down list of all File Cabinet pages on 
your site.  Select the one that is most appropriate for your needs. 

Number of files to display: you may limit the number of files to display before 
displaying a View more>> link.  Clicking on the View more>> link will take you to the 
File Cabinet page containing the files. 

Display:  

 Include border around recent files: places a border around the gadget, if 
selected. 

 Include title: adds a title to the top of the gadget, if selected. 

Click on the Save button to save your changes and close the dialog box.  

Click on the Save button for the page to save your changes and exit edit mode. 
  

Figure 3-3 

Insert tab>Recently 
updated files 
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Lesson 3-4: How to insert a Recent List 
Items Gadget 

  Figure 3-4 

The Announcement, List, and File Cabinet page types allow you to summarize them 
on a Web Page (or any other page type) through the use of a gadget. First, you must 
create one of these page types before it can be summarized using a gadget. 

 To use the List gadget, add it to your page by selecting Insert >> Recent list 
items while in edit mode of any page in your site.   

 Once added, you can configure the gadget based on the following options as 
illustrated in Figure 3-4: 
Show list items from: this option provides a drop-down list of all List pages 
on your site.  Select the one that is most appropriate for your needs. 

Figure 3-4 

Insert tab>Recent list 
items 
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 Select the columns you wish to display: the choices listed here will refresh 
depending on the List page selected in the previous field. 

 Number of list items to show: you may limit the number of list items to 
show before displaying a View more>> link.  Clicking on the View more>> 
link will take you to the List page containing the list items. 

Sorting: 

 First sort by: this will be your first sort item. The sort items available will be 
the column headers from the List page you have selected. 

 Then sort by: this will be your “then by” sort item (2nd sort order). 

 Then sort by: this will be your “then by” sort item (3rd sort order). 

Display:  

 Include border around recent list items: places a border around the gadget, 
if selected. 

 Include title: adds a title to the top of the gadget, if selected. 

Click on the Save button to save your changes and close the dialog box.  

Click on the Save button for the page to save your changes and exit edit mode. 
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Lesson 3-5: How to insert a Text Box 
Gadget 

 
Figure 3-5 

The text box gadget simply allows you to place a text box on your page that contains 
a title. 

 To use the Text Box gadget, add it to your page by selecting Insert >Text Box while in 
edit mode of any page in your site.   

Once added, you can configure the gadget based on the following options as 
illustrated in Figure 3-5: 
Gadget title: if you want a title for the text box, enter one here. 

Width: enter the width you want the text box in pixels, or leave the field blank to 
create a text box at 100% of the width available. 

Text editor: enter the text you want displayed using the text editor. 

Click on the Save button to save your changes and close the dialog box.  

Click on the Save button for the page to save your changes and exit edit mode. 
  

Figure 3-5 

Insert tab>Text Box 
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Lesson 3-6: Embedding Google Apps in 
your Site 

 
Figure 3-6 

Adding objects and apps 

To start adding objects and apps to your site, click Edit page, select Insert, and pick 
the object or app you'd like to insert. 

When the embedded app (a Google Docs Presentation, for example) is updated at its 
source (in this example, within Google Docs), it gets updated automatically within 
Sites.  

Insufficient Privileges 

The ‘Insufficient Privileges’ error message in Google Sites often means there’s an 
item embedded on the page that you don’t have permission to view. The site’s 
permissions can be set differently from any embedded items within the site -- 
including content from other Google products like Google Calendar and Google 
Docs. 

If you think embedded content is causing the error, you may want to try contacting 
an owner or editor of the embedded content. That person needs to share access to 
the embedded content with your Google Account. Of course, it’s also possible that 
nothing’s gone wrong and that the site owner has intentionally restricted the access.  
  

Figure 3-6 

Insert tab 
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Lesson 3-7: Embedding photos from 
Google+ Photos 

Figure 3-7 

Figure 3-8 

 Figure 3-9 

Figure 3-7 

Insert>Google+ 
Photo 

Figure 3-8 

Select a Photo 

Figure 3-9 

Insert>Google+ 
Photo Album 
slideshow 
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You can embed a single photo or an entire album from Google+ Photo Album. To get 
started, click the Edit page icon in the top right corner of the page.  

How to embed a single photo 

1. From the Insert tab select Google+> Photo as illustrated in Figure 3-7. 

2. If you have uploaded photos to Google+ Photos, they will display as illustrated 
in Figure 3-8. If you have never uploaded any photos, click on the Upload 
photos link on the left navigation. 

3. Give the album a name or add the photo to an existing album. Click on the 
Select a photo from your computer button to browse to the location of your 
photo.  Select the image and click on the Open button. Once the picture is 
uploaded it will appear on your page. Use the following toolbar to select 
preferences for the photo: 

 
If you already have photo albums uploaded, simply click the album from which 
you'd like to pick a photo, and once it loads, select the picture you want to 
insert. Click Select and the picture will be added to your page. 

4. Click the Save button. 

Insert a Photo Album Slideshow 

1. From the Insert tab select Google+>Photo Album.  

2. Select one of your albums from the list view, or paste the URL of the album 
you'd like to insert. 

3. Click the Select button. 

4. Select your slideshow options as illustrated in Figure 3-9. 

 

NOTE: make sure the photos you are inserting on your web page from Google+ 
Photos have been shared appropriately or no one will be able to view your photos. 
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Lesson 3-8: Linking to You Tube Videos 
on your Site 

 
Figure 3-10 

 
Figure 3-11 

This lesson will guide you through how to link a You Tube video in your Google Site.  

1. Open a new browser tab and go to the You Tube website. 

2. Search for the YouTube video you want to link on your Google Site and click on 
the link for the video. Copy the url for this video as similarly illustrated in 
Figure 3-10 . 

3. From your Google Site, click on the Edit page icon. 

4. From the toolbar, click on Insert>YouTube. 

5. Paste the YouTube URL in the field provided as illustrated in Figure 3-11. 

Figure 3-10 

You Tube url address 

Figure 3-11 

Insert YouTube Video 
dialog box 
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6. Select your Display preferences and then click on the Save button. 

For additional resources on linking versus embedding YouTube videos, please visit 
the Jeffco Google Apps>YouTube page. 
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Lesson 3-9: Inserting Google Calendars 

  
Figure 3-12 

  Figure 3-13 

You can easily embed as many Google Calendars as you want into your Google Site: 

Figure 3-12 

Insert>Calendar 

Figure 3-13 

Insert Google 
Calendar dialog box 
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1. Navigate to the page where you want to embed your calendar and click 
Edit page. 

2. Place the cursor where you would like to insert your calendar.  

3. From the Insert menu, select Calendar.  

4. Click the name of the calendar you would like to embed as similarly illustrated 
in Figure 3-12, then click Select. 

5. If you would like to display another calendar in the same gadget (as opposed 
to a separate gadget), click the Display another Calendar link as illustrated in 
Figure 3-13. 

Click the name of another calendar you would like to embed, then click Select. 
Repeat these last two steps until you have added all the calendars you want in 
your gadget. This is a great way to “overlay” multiple calendars and display as 
one calendar (events from each calendar will display as separate color blocks). 

6. Choose how you would like your calendars to be displayed by choosing among 
the gadget options as illustrated in Figure 3-13. 

7. Click SAVE. 

8. A box should now appear on your page that reads Google calendar and the 
name of your calendar. Continue editing your page or click Save and you're 
done! 

You'll need to make sure that the calendar is shared as “Any with the link can view” 
or as “Public on the web” in order to avoid an Insufficient Privileges error. 
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Lesson 3-10: Inserting Google Forms 

 
Figure 3-14 

 
Figure 3-15 

You can easily embed a Google Form into your Google Site. Google Forms may be 
created using Google Docs. 

1. Navigate to the page where you want to embed your form and click Edit 
page. 

2. Place the cursor where you would like to insert your form.  

3. From the Insert menu, select Drive>Form (Google Forms are created in Google 
Drive).  

4. Click the name of the form you would like to embed as illustrated in Figure 
3-14 and click Select. 

5. Choose how you would like your forms to be displayed by choosing among the 
gadget options as illustrated in Figure 3-15. 

6. Click SAVE. 

Figure 3-14 

Insert>Drive>Form 
dialog box 

Figure 3-15 

Insert Google Form 
dialog box 
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A box should now appear on your page that reads Google Form and the name of 
your form. Continue editing your page or click Save and you're done! 

You'll need to make sure that the form is shared properly to avoid an Insufficient 
Privileges error. 

 

 





 

 

 

Chapter Four: Site Design 

Chapter Objectives: 

 How to change your Site’s Colors and Fonts 

 How to Change your Site Header 

 Customizing the Sidebar 

 How to Automatically Organize the Navigation Gadget 

 How to Manually Organize the Navigation Gadget 

 How to build Sub-Menus on the Sidebar 

 How to add Custom Links to the Sidebar 

 How to add Gadgets to the Sidebar 

 How to use Horizontal Navigation 

 How to create a Site Footer 

 How to specify the Landing Page (Home Page) 

 How to change your Site Title 
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Lesson 4-1: Changing your Site Colors 
and Fonts 

 
Figure 4-1 

Site colors and fonts 

1. From the More actions menu select Manage site. 

2. Select Themes, Colors, and Fonts from the left navigation.  

3. Customization for colors and fonts include the following categories: 

Entire page 

Site header 

Content area 

Content area gadgets 

Sidebar gadgets 

Horizontal navigation 

4. Each of these categories has multiple items that can be edited as explained in 
the table below.  

5. Once you have finished making your design selections, click the Save button. 

 

Entire Page These options will set the default for your site, though 
you can override much of this formatting by selecting 
specific fonts, colors or images in other sections or by 
formatting on a specific page.  

Background Color: the background color surrounds the content of 
your site and can be set independent from the content 
background color.  Use the Content background color to 
fill the content area. This is how you can have your 
content area be one color and the surrounding area a 

Figure 4-1 

Manage Site>Colors 
and Fonts 
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different color. NOTE: depending on the theme used, the 
page background color may fill the entire page (content 
area and surrounding area).  

Image: to fill the background of the page with an image, 
click on the Browse button. After you have selected the 
file, you may click on the Custom option button. You can 
then specify how you want to place the image on the 
page. NOTE: if you have specified a content background 
color or image independently, the page background image 
will surround the content area. 

Wrapper image: to surround the content area with an 
image, click on the Browse button. After you have 
selected the file, you may click on the Custom option 
button. You can then specify how you want to place the 
image on the page. 

Text Font: the page font controls how the font displays in the 
content area of your website. All other categories allow 
you to select a font independent of the page font. 

Color: the page text color controls the color the text will 
display in the content area of your website.  All other 
categories allow you to select a text color independent of 
the page text color. 

Size: the page text size controls the size the text will 
display in the content area of your website.  All other 
categories allow you to select a text size independent of 
the page text size. 

Link color: the page link color controls the color of 
hyperlinks on your page. Since the sidebar contains 
hyperlinks, this will also change the sidebar link color. 

Visited link color: the page visited link color controls how 
hyperlinked text displays after the link has been visited. 

Site Header If you have not turned off your header, these options 
control content in the area that appears at the top of 
each page.  

Background Color: the site header background color controls the color 
displayed in the header section of your site. 

Image: the site header background image allows you to 
place your own custom designed banner image on your 
site. 

Title Font: the site header title font controls how the font 
displays for your site title. You may specify the site title 
font independent from the page and sidebar fonts. NOTE: 
you must have Show site name at top of pages turned on 
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in Manage site>General to view site titles. 

Color: the site header title color controls the color of the 
font that displays for your site title. NOTE: you must have 
Show site name at top of pages turned on in Manage 
site>General. 

Size: the site header title font size controls how the font 
size displays for your site title. NOTE: you must have Show 
site name at top of pages turned on in Manage 
site>General to view site titles. 

Content area These options control the main page area, where the 
majority of your content displays. You can override this 
formatting by making changes on individual pages.  

Background 

 

Color: the content area background color is the color that 
will fill the area of your website that contains content. Use 
Entire Page Background Color to fill the area surrounding 
the content area. This is how you can have your content 
area one color and the surrounding area a different color. 

Image: the content area background image allows you to 
place an image in the background of the content area by 
clicking on the browse button and selecting a file. Once 
you have selected and uploaded an image, you may select 
from the Options drop-down menu for placement of the 
image in the content area. 

Page title Font: the content area page title font controls how the 
page title will display. This is the title that displays at the 
top of a page and controls the text that displays on the 
navigation bar. 

Color: the content area page title color controls the color 
used for the page title font. 

Size: the content area page title size controls the size of 
font for the page title. 

Headers (H2, H3, H4): Font: the content area headers font controls the font used 
on the headers of gadgets added to your webpage. 

Color: the content area headers color controls the font 
color used on the headers of gadgets added to your 
webpage. 

Text: Font: the content area text font controls the font in the 
main content area of your site. The content area font may 
be selected independent from the site header font, page 
title font and navigation font. 

Color: the content area text color controls the color of the 
font that displays in the main content area of your site. 
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This font color may be selected independent from the site 
header font color, page title font color and navigation font 
color.  

Size: the content area text size controls how the font size 
displays in the main content area of your site. This font 
size may be selected independent from the page title font 
size and navigation font size. 

Content area gadgets These items will format gadgets that you place on your 
page, such as text boxes. 

Background Color: the content area gadget background color controls 
the background color for the content area of gadgets. 

Image: the content area gadget image controls the image 
that displays for the content area of gadgets. 

Title Font: the content area gadget title font controls the font 
used on the titles of gadgets. 

Color: the content area gadget title color controls the font 
color used for the title of gadgets. 

Size: the content area gadget title size controls the font 
size used for the title of gadgets. 

Title background Color: the content area gadget title background color 
controls the color used in the background of the title area 
of gadgets. 

Image: the content area gadget title background image 
controls the background of the title area of gadgets. 

Text Font: the content area gadget text font controls the font 
used in the content text area of gadgets. 

Color: the content area gadget text color controls the font 
color used in the content text area of gadgets. 

Size: the content area gadget text size controls the font 
size used in the content text area of gadgets 

Link color: the content area gadget text link color controls 
the font color of hyperlinks in the content text area of 
gadgets. 

Line divider Color: the content area gadget line divider color controls 
the color of the horizontal line divider. 

Sidebar gadgets If you have not turned off your sidebar, these items will 
format the gadgets that you place in your sidebar. 

Background Color: the sidebar gadgets background color controls the 
color of the background of gadgets added to your sidebar. 

Image: the sidebar gadgets background image allows you 
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to place an image in the background of the headers of 
gadgets added to your sidebar. 

Title Font: the sidebar gadgets title font controls the font used 
for the title area of gadgets added to your sidebar. 

Color: the sidebar gadgets title color controls the color of 
the title text for gadgets added to your sidebar. 

Size: the sidebar gadgets title size controls the font size 
used for the title area of gadgets added to your sidebar. 

Title background Color: the sidebar gadgets title background color controls 
the color used in the background of the titles of gadgets 
added to your sidebar. 

Image: the sidebar gadgets title background image 
controls the image used in the background of the titles of 
gadgets added to your sidebar. 

Text Font: the sidebar gadgets text font controls the font used 
for gadgets added to your sidebar. 

Color: the sidebar gadgets text color controls the font 
color used for gadgets added to your sidebar. 

Size: the sidebar gadgets text size controls the font size 
used for gadgets added to your sidebar. 

Link color: the sidebar gadgets text link color controls the 
color used for hyperlinked text on gadgets added to your 
sidebar. 

Visited link color: the sidebar gadgets text visited link 
color controls the color used for visited hyperlinked text 
on gadgets added to your sidebar. 

Selected text Text color: the sidebar gadgets selected text color controls 
the color used for selected text on gadgets added to your 
sidebar. 

Background color: the sidebar gadgets selected text 
background color controls the background color used for 
selected text on gadgets added to your sidebar. 

Line divider Color: the sidebar gadget line divider color controls the 
color of the horizontal line divider. 

Horizontal navigation If you have chosen to include a horizontal navigation bar, 
these options will format your horizontal menus. 

Background Color: the horizontal navigation background color controls 
the background color when an item on the horizontal 
navigation bar is selected. 

Hover color: the horizontal navigation background hover 
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color controls the background color when an item on the 
horizontal navigation bar is hovered over. 

Text Font: the horizontal navigation text font controls the font 
on the navigation for the active page. 

Color: the horizontal navigation text color controls the 
text color on the navigation for the active page. 

Size: the horizontal navigation text size controls the text 
size on the navigation for the active page. 

Hover color: the horizontal navigation text hover color 
controls the hover color on the navigation for the active 
page. 

Selected text Text color: the horizontal navigation selected text color 
controls the text color when an item on the horizontal 
navigation bar is selected. 

Background color: the horizontal navigation selected text 
background color controls the background color when an 
item on the horizontal navigation bar is selected. 

Dropdown Text color: the horizontal navigation dropdown text color 
controls the color of the text in drop-down menus. 

Background color: the horizontal navigation drop-down 
background color controls the color of the background in 
drop-down menus. 

Hover color: the horizontal navigation drop-down hover 
color controls the color of the text in drop-down menus 
when hovered over. 

Hover background color: the horizontal navigation drop-
down hover background color controls the background 
color in drop-down menus when hovered over. 

Layout Alignment: the horizontal navigation layout alignment 
controls the alignment of navigation tabs, links or boxes. 

Margin: the horizontal navigation layout margin controls 
the margins of navigation tabs, links or boxes.  
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Lesson 4-2: Changing the location and 
width of the Sidebar on your Site 

  Figure 4-2 

 
Figure 4-3 

 

The sidebar acts as your main source of navigation within Google Sites and may be 
designed to display on the left, right or top of your site. 

How to change the Sidebar location and width 

1. Select Edit site layout from the More actions menu. 

2. Click on the Edit icon for the Sidebar as illustrated in Figure 4-2.  

3. Select your display preference, left or right, as illustrated in Figure 4-3. 

4. Change your sidebar width by entering a pixel value in the Width field. 

5. Click on the OK button. 

NOTE: to change to Horizontal Navigation, please see Lesson 4-7: How to use 
Horizontal (Top) Navigation. 
  

Figure 4-2 

Sidebar Edit icon 

Figure 4-3 

Edit sidebar dialog 
box 
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Lesson 4-3: How to Automatically 
Organize the Navigation Gadget 

Figure 4-4 

 Figure 4-5 

You can add pages to, delete pages from and organize your sidebar's navigation 
gadget in two different ways. Automatic organization takes less time, but manual 
organization gives you greater control over how your navigation is structured.  

Using automatic organization 

If you want to quickly set up your sidebar navigation gadget, you can have the 
navigation gadget automatically display pages according to how your site is 
structured:  

1. Select Edit site layout from the More actions menu. 

2. The Edit site layout toolbar will display as partially illustrated in Figure 4-4.  

3. Hover over the sidebar to display an Edit sidebar item marker.  Click any place 
on the sidebar. The Configure Navigation dialog box will display as illustrated 
in Figure 4-5. 

4. If you want, you can type a name for the navigation gadget in the box next to 
Title and check the box next to Display title to have that name displayed at the 
top of your navigation gadget. You can disable a name from displaying by 
unchecking Display title. 

5. Make sure the box next to Automatically organize my navigation is checked.  

6. Choose how many levels of pages you want to be included in the navigation 
menu by choosing a selection from the drop-down menu. For example, if you 

Figure 4-4 

More>Edit site layout 
toolbar 

Figure 4-5 

Configure Navigation 
dialog box 



 Site Design 67 

 

Jeffco Schools 

choose 2, the sidebar will display any top-level pages and pages listed under 
them, but will not display any subpages listed under those second-level pages.  

7. You can choose to include a link to your Sitemap (which displays the hierarchy 
of your site) and your Recent site activity (which allows you to subscribe to 
page changes) by checking the box next to those options. 

8. Click OK.  

9. Click the Close button (upper right). 

How to change the location of pages on the Sidebar 

If you have chosen to have your navigation gadget automatically organized and you 
want to change the order of pages, you may manually change the location of your 
pages.  

1. Navigate to the page that you want to move.  

2. From the More actions menu, click Move page. NOTE: you may not move your 
Home (Landing) page. 

3. Select the page where you want this page to appear under (as a subpage).  

4. Click Move. 
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Lesson 4-4: How to Manually Organize 
Sidebar Navigation 

Figure 4-6 

If you want more control over your sidebar navigation, you can manually 
organize your pages.  

1. Select Edit site layout from the More actions menu. 

2. Hover over the sidebar to display an Edit sidebar item marker.  Click any place 
on the sidebar to display the Configure navigation dialog box. 

 If you want, you can type a name for the navigation gadget in the box 
next to Title and check the box next to Display title to have that name 
displayed at the top of your navigation gadget. 

 Make sure the box next to Automatically organize my navigation is 
unchecked as illustrated in Figure 4-6.  

 To add an existing page from your site to your navigation gadget, click 
Add page. Then locate your page in the pop-up window and click OK. 
Pages can only be added one at a time. 

Figure 4-6 

More>Edit site layout 
– Configure 
navigation 
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 To delete a page from your navigation gadget, select the page in the 

Select pages to show box, then click on the  remove icon.  

 To change the order in which your pages appear, or build a sub-menu, 
select the page in the Select pages to show box, then click the up 
arrow, down arrow, right arrow, or left arrow. When you use the 
right arrow to indent a web page under another web page, you are 
effectively building a sub-menu structure. Your pages will appear in your 
navigation gadget in the same order in which they appear in the Select 
pages to show box.  

3. You can choose to include a link to your Sitemap (which displays the hierarchy 
of your site) and your Recent site activity (which allows you to subscribe to 
page changes) by checking the box next to those options. 

4. Click OK. 

5. Click on the Close button (upper right). 
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Lesson 4-5: How to add custom links to 
the Sidebar 

  Figure 4-7 

  Figure 4-8 

To add custom links on the navigation gadget, follow these steps: 

1. Select Edit site layout from the More actions menu. 

2. Hover over the sidebar and click anywhere to display the Configure navigation 
dialog box. 

Figure 4-7 

More>Edit site layout 
–  Configure 
Navigation dialog box 

 

Figure 4-8 

Add URL dialog box  
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3. Make sure the checkbox next to Automatically organize my navigation is not 
checked as illustrated in Figure 4-7.  

4. To link to another website, or an email address, on your sidebar, click Add URL 
as illustrated in Figure 4-7.  

5. In the pop-up window illustrated in Figure 4-8, enter the Text to display on the 
sidebar and enter the URL or email address in the field provided. If entering an 
email address, be sure to include mailto: as the prefix to the email address and 
make it all one word.  

Example: mailto:jsmith@jeffco.k12.co.us 

6. Click OK. 

7. Click on the Close button.  
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Lesson 4-6: Adding Items to the Sidebar 

Figure 4-9 

  Figure 4-10 

Adding and deleting items to your sidebar 

Once you are in Edit site layout mode (select Edit site layout from the More actions 
menu), you can add various items to your sidebar by clicking the Sidebar + (plus) 
icon, then selecting a item from the list.  

You can edit or delete any item on your sidebar by clicking on Edit sidebar item or 
by clicking the delete icon next to the item’s name.  

 Adding items: to add an item, click on the + icon next to Sidebar as illustrated in 
Figure 4-9. Then, find the item in the list you want to add and click the Add 
button as illustrated in Figure 4-10. The item will now be listed on the sidebar. 
You may edit the item by clicking on the edit link next to the item. 

 Reordering items: to reorder your items, click on the item you want to move 
and drag it to the position where you want it to appear on the sidebar.  

 Deleting items: to delete an item, click the delete icon next to the item.  

  

  

Figure 4-9 

Sidebar add item icon 

Figure 4-10 

Choose a New 
Sidebar Item dialog 
box 
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Lesson 4-7: How to use Horizontal (Top) 
Navigation 

Figure 4-11 

 Figure 4-12 

Jeffco Google Site templates for schools are designed with left sidebar navigation. If 
you would like to change the left sidebar navigation to horizontal top navigation, this 
lesson is for you!  

NOTE: Jeffco Departments are asked to keep left sidebar navigation for consistency 
purposes. 

Figure 4-11 

Edit site layout 

 

Figure 4-12 

Configure navigation 
dialog  
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To enable and build the Horizontal Navigation, follow these 
steps: 

1. Select Edit site layout from the More actions menu. 

2. To disable the sidebar, click on the Sidebar button. 

3. To enable the horizontal navigation, click on the Horizontal navigation button 
as illustrated in Figure 4-11 . 

4. Hover over the horizontal navigation area of the page and click inside the Edit 
horizontal navigation area. 

From the Configure navigation dialog box, click on the Add page link as 
illustrated in Figure 4-12 and begin adding pages you want displayed on the top 
navigation. You may only select one page at a time to add to the navigation bar. 
Once you click on a page, click on the OK button. The page is added to the list 
box as the last item in the list. You may need to scroll down in the list to see the 
page. 
 
You may sort the page by using the up or down arrow button. You may indent 
the page under a top level page (creating a sub-menu) by using the right arrow 
button. To outdent a sub-menu item (creating a top level item again), use the 
left arrow button. To delete a navigation bar item, (perhaps you want to keep 
the page hidden) simply select the page and press the delete icon. 
 
Keep in mind that pages added that are not subsequently indented under a top 
level page will display as its own tab (box, or link) on the horizontal navigation 
bar.  

5. Continue adding all pages you want to appear on the horizontal navigation – 
whether as a top level or as a sub-menu item. 

6. After sorting your pages in the order you want them to display and organizing 
your sub-menus, choose the Style you want to display: boxes, tabs or links. 

7. When you are finished with your horizontal navigation properties, click on the 
OK button. 

8. Click on the Close button (upper right). 
 

Remember, all new pages you add hereafter will need to be manually added to the 
horizontal navigation. This can only be done by returning to the Configure 
navigation dialog box. 
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Lesson 4-8: How to add a Subpage Listing 
to a Web Page 

       Figure 4-13 

Add a subpage listing 

Often times, when you build a submenu of pages under a parent level page, the 
parent level page doesn’t really have any content. An ideal way to place content on 
this type of page is to add a subpage listing to the parent level page.  

To add a subpage listing to a parent level web page, follow these steps: 

1. Click the parent level page in the sidebar and then click the Edit page icon. 

2. Click Insert > Subpage listing.  

3. Enter the title of the parent page in the Title field.  

4. Select the Appearance of the listing. 

5. Click the Save button. 

You'll now have sub-menus for your pages. You can repeat this for all top level pages 
and subpages.  
  

Figure 4-13 

Insert Subpage 
Listing dialog box 
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Lesson 4-9: Creating/Editing a Site Footer 

 
Figure 4-14 

The site footer is a section that appears at the bottom of every page on a site and 
typically contains information, such as a contact email address or phone number 
that is useful or applicable no matter which page your visitor is viewing.  

DEPARTMENT WEB SITES SHOULD NOT EDIT OR CHANGE THE FOOTER IN ANY 
WAY! ALL DEPARTMENT WEB SITES ARE TO HAVE THE SAME FOOTER SO THAT 
NAVIGATION TO OTHER WEB SITES IS STANDARD. 

 

To edit the footer on your Site (school websites only) 

1. Select Edit site layout from the More actions menu. 

2. Hover over the bottom, or footer, portion of the page until you see the Click to 
edit custom footer marker. Click anywhere in this location to display the Edit 
site footer dialog box as similarly illustrated in Figure 4-14. 

3. Using the text editor, enter the information you want displayed in the footer 
section of each page.  

4. Click OK.  

5. Click the Close button.  

Figure 4-14 

More actions menu> 
Edit site layout -  Edit 
site footer 
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NOTE: While you can add and customize your own footer, you cannot edit the 
permanent site footer, a line of text that includes navigation and access information 
for the site. 

 

REMEMBER 
DEPARTMENT WEB SITE OWNERS SHOULD NOT EDIT OR CHANGE THE FOOTER IN 
ANY WAY! ALL DEPARTMENT WEB SITES ARE TO HAVE THE SAME FOOTER SO THAT 
NAVIGATION TO OTHER WEB SITES IS STANDARD. 
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Lesson 4-10: Setting a Landing Page (aka 
Home Page) 

 
Figure 4-15 

The landing page (home page) for your site is the page people will see when you link 
to the base level of your site. For example, 
http://sites.google.com/a/jeffcoschools.us/mysitename  

To set the landing page for your site: 

1. From the More actions menu, select Manage site.  

2. By default the General page should display. If this is not the page selected, 
select General from the left navigation. 

3. Choose the page you would like for your landing page by clicking on the 
Change link as illustrated in Figure 4-15 (the default is Home).  

4. Click the Save button.  

NOTE: you can't delete a page that has been designated as the landing page. You 
must assign a new landing page and then delete the old landing page. 

  

Figure 4-15 

Manage site>General 
– Landing page 
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Lesson 4-11: How to configure site 
Search  

Figure 4-16 

Figure 4-17 

 

Figure 4-16 

Manage Site/Site 
layout 

Figure 4-17 

Configure site search 
General tab 
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How to enable Search 

To enable search for your site: 

1. From the More actions menu, select Manage site. 

2. Select the General tab. 

3. Click on the Configure search button as illustrated in Figure 4-16. 

4. From the General tab, check Enable Search as illustrated in Figure 4-17. 

5. Click OK and then click Save to save your search settings. 

 

To change the location of the Search box on the site header: 

1. From the More actions menu drop-down menu, select Edit site layout. 

2. Click inside the header section of the page. 

3. In the Height section, choose a pixel height as appropriate for your header 
image. You need to make the height deep enough so that the Search box 
displays at the bottom of this area below your banner. 
In the Alignment section, select Center for Horizontal placement (leave Vertical 
as bottom): 

 

4. Click on the OK button. 

5. Click on the Close button (upper right). Example: 

 
 





 

 

 

Chapter Five: Managing 
Your Site 

Chapter Objectives: 

 How to change your Page URL 

 How to change the Name of your Website 

 How to Delete and Restore Sites 

 All about Site Sharing 

 How to remove someone from having access to your site 

 How to manage visitor subscriptions to your site 

 How to use Revision History 

 

 



86 Google Sites 

IT Training Center, 6.30.15 

Lesson 5-1: How to change your Page 
URL 

 
Figure 5-1 

Your page has two separate attributes -- the page URL and the page title, also 
referred to as the page name. These are both different from and independent of 
your site URL and site name, which are linked to each other.  

When you create a page, you will be prompted to give your page a name, and that 
name will be used to automatically create the page URL. However, you can change 
your page name or change your page URL independent of each other at any time.  

How to change your Page URL 

1. Navigate to the page whose URL you want to change.  

2. From the More drop-down menu, select Page settings.  

3. In the box below Page URL, as illustrated in Figure 5-1, type in what you want 
the last part of the page's URL to be. (Note, the beginning part of the URL is 
dictated by the structure of your website. For example, if you want to edit your 
page URL to be "Mr. Smith Biology", which you previously called "jsmith", the 

Figure 5-1 

Page Settings dialog 
box 

 



 Managing Your Site 87 

 
 

Jeffco Schools 

page's full URL would be 
http://sites.google.com/a/jeffcoschools.us/jsmith/mr-smith-biology).  

4. Click the Save button. 

NOTE: You will only be able to use alphanumeric characters and dashes in your page 
URL. 
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Lesson 5-2: How to change your Site URL 

Figure 5-2 

   Figure 5-3 

Jeffco is using the following standard naming conventions for Google sites: 

School Sites: 

Approved Naming Convention: “(schoolname)-(gradelevel)”  
Examples: arvada-hs, bell-ms, stein-es, coalcreek-k8, govsranch-es 

School name will be 1 word, depending on the name of the school. If the name of 
the school is very long, or is longer than 2 words, a truncated or abbreviated version 

Figure 5-2 

Manage site>General 
tab 

Figure 5-3 

Copy this Site dialog 
box 
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of the school name can be used. (RMAE instead of Rocky Mountain Academy of 
Evergreen, Govsranch instead of Governor’s Ranch.) 

Grade Level will be a 2 letter abbreviation of the school level (ES, MS, HS, K8, K5, 
etc…)  

Teacher/Classroom Sites: 

Recommended Naming Convention: (AD Username) 

AD Username will be the users ESS name (jsmith).  

Subject would only be needed if the teacher has multiple websites for different 
classes/subjects, to uniquely identify each site (AD Username)-(subject).  

It is generally a bad idea to include subject, grade level or school name in the site url 
name because teachers often times move schools or teach different grade levels (or 
subjects) from year to year. If a teacher chooses to do this anyway, they can copy 
their website to a new website to assign a new site name url that better reflects 
what they are teaching. 

If you were not aware of these naming conventions, you can easily copy your 
website to a new website and rename it by following the instructions below.  

1. From the More actions menu, select Manage site. 

2. From the General page, click the Copy this Site button as illustrated in Figure 
5-2. 

3. In the Site name field, enter a name for the site as illustrated in Figure 5-3. 

4. For Site location, make sure you are using the Jeffco approved naming 
conventions. This will be the permanent url for the site. 

5. Click the Copy button. 

6. You will now have an exact copy of the website with the new URL. On the old 
website, delete the old content and type a notice saying something like "This 
Site has moved to a new location." in big, brightly colored text and list the url 
of your new website. Notify parents, school webmaster, etc. of the change. 
After a while, you can go back to this old website and delete it. Please see 
Lesson 5-3: How to Delete and Restore Sites. 

 

NOTE: If you are copying a site so that another teacher's site has the same 
style/format as the original, you will then need to go to that new site and give that 
teacher access to the new site. 
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Lesson 5-3: How to Delete and Restore 
Sites 

 
Figure 5-4 

 
Figure 5-5 

 

Figure 5-4 

Manage site>General 
page 

Figure 5-5 

My Sites page 
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To delete a site, follow these steps: 

1. Select Manage site from the More actions menu. 

2. From the General tab, click the Delete this Site button as illustrated in Figure 
5-4. 

To restore a deleted site, follow these steps: 

1. Click on the Sites link on the menu bar. 

2. Click on the Deleted Sites link on the left navigation. 

3. Click on the Restore Site link for the site you want to restore as illustrated in 
Figure 5-5.  

NOTE: sites that have been deleted may be restored for up to 30 days. Beyond 
30 days they will automatically be permanently removed by Google. 
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Lesson 5-4: Overview of Site Sharing 

 
Figure 5-6 

An overview of site sharing 

You can control who can view or edit your site by changing the sharing settings on 
your site. If you want everyone to be able to view your site without signing in to a 
Google Account, you can set your site as public on the web or anyone with the link. 
Alternatively, you can specify which people can do certain actions on your site by 
setting their access level to Can view, Can edit, or Is owner: 

Users set to Can view can: 

 View pages only 

Users set to Can edit can: 

 Edit and delete pages  

 Move pages  

 Add attachments  

 Add comments  

 Subscribe to site and page changes  

Users set to Is owner can: 

Figure 5-6 

Visibility options 
dialog box 

 

https://sites.google.com/support/bin/answer.py?hl=en&answer=98182
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 Do everything that “Can edit” users can do  

 Set other people as Can view, Can edit, and Is owner  

 Add pages 

 Change site themes and layout  

 Change the site name  

 Delete the site  

Unlocking pages 

The warning "Break Lock" appears when more than one person are editing a page at 
the same time. By breaking the lock it will enable you to gain control over the page 
and edit it. However, be careful as breaking a lock affects your saving capabilities. If 
you choose to break a lock, and the other editor saves after you have saved your 
new changes, their version will overwrite your edits and vice-versa. 

You cannot work on the same web page at the same time as someone else! 
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Lesson 5-5: How to Share your Site 

 Figure 5-7 

 Figure 5-8 

Sharing your site with other people 

If your site is private, you can share your site to allow individual people to view or 
edit your site. If your site is public on the web, your site will already be viewable by 
anyone, but you can share your site to allow other people to edit your site. Follow 
these steps to share your site with other people:  

1. Click on the Share button.  

Figure 5-7 

Sharing and 
Permissions dialog 
box 

Figure 5-8 

Add people settings 
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2. In the box below Invite people, enter the Gmail addresses of the people you 
wish to share your site with as illustrated in Figure 5-7. NOTE: Jeffco Gmail 
accounts use @jeffcoschools.us appended to user names. 

3. Choose the level of access you wish to give them by selecting from the Can 
edit drop-down menu as illustrated in Figure 5-8. Anyone you set to Can view 
can look at the site; Can edit can change the content of the site; Is owner can 
change the look and content of the site as well as make administrative 
changes, such as deleting the site or adding new owners.  

4. The people whose email addresses you added will be sent an automated email 
message when you add them unless you uncheck the box next to Notify 
people via email. If you choose to send the group a notification, you can add a 
personalized message by clicking on the Add message link. You can also opt to 
have the notification sent to you as well by checking the box next to Send a 
copy to myself.  

NOTE: the automated email will be sent to the user’s Gmail account, not their 
Jeffco Exchange (Outlook) email. They will need to login to Gmail to see this 
message, or have Gmail configured to forward messages to their Jeffco Exchange 
(Outlook) email account. 

5. Click the Share & save button. 

 

You can copy your website so another teacher can use the same 
"look and feel" of your site by following the instructions below: 

NOTE: many schools have already created templates for their teachers. If your 
school has already created templates, you may select the template when creating a 
new site rather than copying one over as described below.  

1. From the More  drop-down menu select Manage site. 

2. From the General page click the Copy this Site button. 

3. In the Site name field, type the teacher's AD user name (for example: jsmith). 

4. For Site location, the teacher's AD user name will go here also. 

5. Click the Copy button. 

6. You will now have an exact copy of your website with the new url. 

7. You will then need to go to the new site and make that teacher the owner of 
that new site. 

Once you are at the new site: 

1. Click on the Share button. 

2. Under the Invite people field, enter the Jeffco gmail address of the teacher for 
which you are duplicating your site. 

3. Choose Is Owner as the level of permission you are giving them. 

4. Click the Share & save button.  
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Lesson 5-6: Removing access from your 
Site 

 
Figure 5-9 

To remove access from your site:  

1. Click the Share button.  

2. Locate the person you wish to remove from the site, and click the X next to 
their level of access as illustrated in Figure 5-9.  

3. Click the Save changes button. 

Figure 5-9 

Sharing and 
Permissions dialog 
box 
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Lesson 5-7: Revision History 

 
Figure 5-10 

If you've made a mistake on a page or want to see what changes have been made to 
a page, you can revert to an earlier version of your page. Just follow these 
instructions:  

1. Navigate to the page that you want to revert back to a previous version.  

2. From the More drop-down menu, select Revision history.  

3. To look at a previous version of your page, click on the version number as 
similarly illustrated in Figure 5-10. While looking at this version, you can 
replace your current page with this version by clicking Revert to this version. In 
addition, you can compare any version of your page to any other version of 
your page (including the current page). Select the first version you want to 
view from the list and then click Compare two versions and choose the second 
version you would like to compare.  

4. If you are done looking at a version of your page and want to choose other 
versions to look at, click << back to version history listing.  

Any page that you replace with an earlier version will also be saved in your revision 
history, so don't worry -- you can always get it back. 

Figure 5-10 

Revision History 

 


